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Funding Proposal Template
If you’re trying to raise money, it’s crucial that you present your organization or project in the best possible light. We’ve made it easy to impress with our free and fillable funding proposal template. Start customizing in minutes!

How to Create a Startup Funding Proposal: 8 Samples and Templates to Guide You

Being a founder is difficult. Managing the day-to-day as a founder while trying to secure capital for your business can almost feel impossible. Thankfully, there are different tools and techniques that founders can use to systemize their fundraise to focus on what truly matters, building their business.
One of those tools is a startup funding proposal. In this guide, we’ll break down what a startup funding proposal is and how you can leverage it to build momentum in your fundraise.
What Is a Startup Funding Proposal?
A startup funding proposal is a document that helps startup founders share an overview of their business and make the case for why they should receive funding. A startup funding proposal can be boiled down to help founders layout 3 things:
	What — what does your startup do
	How — how does your startup or product help customers accomplish what they are seeking
	Why — why does your startup need funding and why should an investor fund your business

Related Resource: How to Write a Business Plan For Your Startup
Types of Startup Funding Proposals
Like any business document, there are many ways to approach a startup funding proposal. Ultimately it will come down to pulling the pieces and tactics that work best for your business. Investors are seeing hundreds, if not thousands, of deals a month so it is important to have your assets buttoned up to move quickly and build conviction during a raise. Check out a couple of popular types of funding proposals below:
Traditional Startup Funding Proposal
The most traditional or “standard” standard funding proposal is generally a written and visual document that is created using word processing software and/or design tools.
A traditional proposal is great because it allows you to share context with every aspect of your business. For example, if you include a chart of growth you’ll be able to explicitly write out why that was and what your plan is for future growth.
This document is generally designed to fit your brand and will hit on the key components of your business is structured and predictable way. We hit on what to include in your proposal below.
Startup Funding Proposal Pitch or Presentation
The most common approach we see to a fundraise or proposal is the pitch deck. Pitch decks take the same components as any proposal and fit them into a visual pitch deck that can be easily navigated and understood by a potential investor.
Pitch decks are not required by investors by are generally expected and are a great tool that can help you efficiently close your round. To learn more about building your pitch deck, check out a few of our key resources below:
	Tips for Creating an Investor Pitch Deck
	18 Pitch Deck Examples for Any Startup
	Our Teaser Pitch Deck Template

1-on-1 Proposals (Elevator Pitch)
A 1 on 1 proposal or an elevator pitch is the quickest version of any proposal. Every founder should have an elevator pitch in their back pocket and is a complementary tool to any of the other funding proposals mentioned here.
As the team at VestBee puts it, “Elevator pitch” or “elevator speech” is a laconic but compelling introduction that can be communicated in the amount of time it takes someone to ride an elevator, usually around 30 seconds. It can serve you for fundraising purposes, personal introduction, or landing a prospective client.”
Email Proposal
Another common way to share a startup funding proposal via email. While the content might be similar to what is seen in a “traditional” funding proposal this allows you to hit investors where they spend their time – their inbox.
The format will follow a traditional proposal with less emphasis on visual aspects and more emphasis on the written content. Check out an example from our Update Template Library below:
Related Resource: How to Write the Perfect Investment Memo
Investor Relationship Hub
Lastly, there is an investor relationship hub or data room that can be used to share your proposal with potential investors. A hub is a great place to curate multiple documents or assets that will be needed during your fundraise. For example, you could share your funding proposal and your financials if they are requested by a potential investor.
Related Resource: What Should be in an Investor Data Room?
What to Include in Your Startup Funding Proposal
How you share your funding proposal might differ but ultimately the components are generally closely related from one proposal to the next. However, be sure that you are building this for your business. There is no prescriptive template that will work for every business.

Project Summary
First things first, you’ll want to start with a summary of your project or your business. This can be a high-level overview of what your proposal encompasses and will give an investor the context they need for the rest of the proposal. A couple of ideas that are worth hitting on:
	What your company does and how it’s different from existing solutions to pressing problems.
	Existing market gaps and how your product covers them.
	The importance of your product in your industry and how it improves the industry.
	Existing resources and manpower, investment requirements, and potential limitations.

Current Performance and Financial Report
Of course, investors want to see how your business has been performing. The data and metrics around your business are generally how an investor builds conviction and further interest in your business. We suggest using your best judgment when it comes to the level of metrics or financials that you’d like to share. A couple examples of what you might share:
	Current assets and liabilities
	MVP presentation for companies still in the ideation stage
	Appendix with financial reports

Related Resource:  Building A Startup Financial Model That Works
Existing Investors and Partners
Inevitably investors will want to know who else you have raised capital from and partnered with in the past. Include a brief description of the different investors you have on your cap table and be ready to field additional questions if they have any.
Pro tip: The first place an investor will go to when performing due diligence is your current investors. Make sure you have a strong relationship and good communication with your current investors.
Market Study and Sales Goals
Investors will also care about your customer acquisition efforts and want to make sure you can repeatably find and close new customers. A couple of things that might be important to include in this section:
	Product pricing and information
	Revenue targets and goals
	Customer acquisition model and efforts
	Sales and marketing related KPIs
	Stories or testimonials from happy customers

Current Valuation, Investment Requirements, and Expected Returns
This is an opportunity to lay out your cap table and explain your current valuation, investment requirements, and what future valuations could look like. As always, we suggest using your best judgment when it comes to what level of detail you’d like to share about your cap table.
Potential Pitfalls and Solutions
There is an inherent risk when investing in any startup. It is important to make sure potential investors are aware of this. Layout the common pitfalls your startup might face and stop you from achieving your goals. Next, lay out the solutions to these problems and how you plan to tackle them if/when they arise.
8 Startup Funding Proposal Samples and Templates
Below are 8 proposal templates to help you kick off your next fundraise. Note that some of these are technically investor updates and not designed for first-time fundraising. Keep in mind that a startup funding proposal could also be utilized for additional funding after the first round of funding.
1. An Investment Summary Template by Underscore VC

Underscore VC is a seed-stage venture fund based out of Boston. As the team at Underscore writes :
“As part of this, we strongly recommend you write out a pitch narrative before you start to build a pitch deck. “Writing the prose forces you to fill in the gaps that can remain if you just put bullets on a slide,” says Lily Lyman, Underscore VC Partner. “It becomes less about how you present, and more about what you present.”
This exercise can help you synthesize your thoughts, smooth transitions, and craft a logical, compelling story. It also helps you include all necessary information and think through your answers to tough questions.
Check out the template here .
2. The Visible “Standard” Investor Update Template
Our Standard investor update template is great for communicating with existing investors. If you are regularly sending Updates to their investors they should know when you are beginning to raise capital again and can almost be treated as an investment proposal.
Check out the template for our standard investor update template here .
3. Sharing a Fundraising Pitch via Video

Videos are a great way to give the right context to the right investors in a concise and quick way. Video is a great supporting tool for any other information or documents you might be sending over. For example, you can include a few charts or metrics and some company information and use the video to further explain the data and growth plans. Check out the template here .
4. Financial Funding Proposal
The team at Revv put together a plug-and-play financial funding proposal. As they wrote, “A funding proposal must provide details of your company’s financials to obtain the right amount of funding. Check out our funding proposal template personalized for your business.” Check out the template here .
5. Investor Proposal Template for SaaS Companies
The team at Revv put together a template to help founders grab the attention of investors. As they wrote, “With so many Investing Agencies, this Investor proposal will surely leave an impact on your company in the long run.” Check out the template here .
6. Startup Funding Proposal Sample
Template.net has created a downloadable funding proposal template that can be edited using any tool. As they wrote, “Get your business idea off the ground by winning investors for your business through this Startup Investment Proposal. Fascinate investors with how you are going to get your business into the spotlight and explain in vivid detail your goals or target for the business.” Check out the template here .
7. Simple Proposal Template
Best Templates has created a generic proposal template that can be molded to fit most use cases. As they wrote, “Use this Simple Proposal Template for any of your proposal needs. This 14-page proposal template is easily editable and fully customizable using any chosen application or program that supports MS Word or Pages file formats.”
8. Sample Investment Proposal for Morgan Stanley
Another example is from the team at Morgan Stanley. The template is commonly used by their team and can be applied to most proposal use cases.
Connect With More Investors and Tell Your Story With Visible
Being able to tie everything together and build a strategy for your fundraise will be an integral part of your fundraising success. Check out how Visible can help you every step of the way below:
Visible Connect — Finding the right investors for your business can be tricky. Using Visible Connect, filter investors by different categories (like stage, check size, geography, focus, and more) to find the right investors for your business. Give it a try here .
Pitch Deck Sharing — Once you’ve built out your target list of investors, you can start sharing your pitch deck with them directly from Visible. You can customize your sharing settings (like email gated, password gated, etc.) and even add your own domain. Give it a try here .
Fundraising CRM — Our Fundraising CRM brings all of your data together. Set up tailored stages , custom fields , take notes, and track activity for different investors to help you build momentum in your raise. We’ll show how each individual investor is engaging with your Updates, Decks, and Dashboards. Give it a try here .
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How to Write Winning Business Proposal: Examples & Free Templates (2024)
By Aditya Sheth , Jan 25, 2024

The great Mark Cuban once said, “Sales cure all.” If a business doesn’t sell, it doesn’t make money and by extension the business fails. That’s why you need to write business proposals .
A well-written business proposal can often mean the difference between winning or losing a prospective client.
In this in-depth guide to creating business proposals, we show you how to close more deals, make more sales and crush your business goals — all by using easy-to-edit professional business proposal templates .
Here’s what this guide will cover (click to jump ahead):
What is a business proposal.
	How to write a business proposal step by step

What should you include in a business proposal?
What are the types of business proposals, more business proposal examples + writing and design tips.
	FAQs about business proposals

Looking for a shortcut? Watch this quick video for an overview of everything to include in your business proposal:

An effective business proposal is a document used by a B2B or business-facing company (this may not always be the case) where a seller aims to persuade a prospective buyer into buying their goods or services.
A business proposal outlines what your business does and what you can do for your client . It can be general like this business proposal example:

Or it can be more specific, like this business proposal template which focuses on proposing a project for the Newton Center Rail:

Or this business proposal sample, which presents a plan for a social media strategy and campaign:

To design a business proposal that holds the client’s attention, identify their pain points . Then provide your buyer with the right solution to alleviate those frustrations.
How to write a business proposal step by step
Before you start creating your business proposal template, you need to understand the business proposal format. At a high level, your effective business proposal should include the following:
Table of contents
Executive summary, the problem statement, the proposed solution, qualifications, the timeline, pricing, billing, and legal, terms and conditions, the acceptance.
Below, you can see business proposal examples that demonstrate how to include these 10 sections.
Business proposal title
A compelling title could mean the difference between someone reading your proposal or ignoring it in favor of a competitor’s . 
What makes a good title page? Here are the essential elements to include: 
	Your name along with your company’s name
	The name of the prospect (or their business) 
	The date you’re submitting the proposal


The gray business consulting proposal template above contains all the details a prospect would want to know. The title also offers a strong tangible benefit to the prospective buyer. Honestly, “Who doesn’t want to grow their business?”
The table of contents is a fundamental part of every winning business proposal template. It makes your proposal scannable and easy to read.
The people you will be pitching to are usually C-level executives. These are busy people who don’t have time to read your entire proposal in one go.
That’s why most of the business proposal examples in this list include a table of contents.
Adding a table of contents to your document makes it easy for them to go through it at their own pace. They can also skim through parts of the proposal that they deem more important. You can see how this abstract business proposal template uses the table of contents:

You can also make your business proposal template easier to navigate by adding hyperlinks to the document, particularly in the table of contents. This way your clients can jump to specific sections without having to scroll through the entire document. 
It’s easy to add hyperlinks in the Venngage editor. Select the text you’d like to turn into a link, then click the link icon in the top bar. From there, select the page you want to link to! Then download your completed design as an Interactive PDF .

The executive summary is a staple in all kinds of annual reports , leadership development plan , project plans and even marketing plans . It is a concise summary of the entire contents of your document. In other words, write a business proposal outline that is easy to glance over and that highlights your value proposition.
The goals of your executive summary are:
	Introduce your company to your buyer
	Provide an overview of your company goals
	Showcase your company’s milestones, overall vision and future plans
	Include any other relevant details

This gray business proposal example has a detailed yet short executive summary including some social proof in the form of clients they’ve worked with:

Take note of how precise this business proposal example is. You want to keep your executive summary concise and clear from the get-go. This sets the right tone for the rest of your proposal. It also gives your buyer a reason to continue reading your proposal.
Pro Tip: Try to write an executive summary such that, even if your prospective client doesn’t read the entire proposal (with a good executive summary, they most likely will), they should have a clear idea about what your company does and how you can help them.
The point of writing a business proposal is to solve a buyer’s problem. Your goal is to outline the problem statement as clearly as possible. This develops a sense of urgency in your prospect. They will want to find a solution to the problem. And you have that solution.
 A well-defined problem statement does two things: 
	It shows the prospect you have done your homework instead of sending a generic pitch
	It creates an opportunity for you to point out a problem your prospect might not be aware they had in the first place. 


This bold business proposal template above clearly outlines the problem at hand and also offers a ray of hope i.e. how you can solve your prospect’s problem. This brings me to… 
The good stuff. In the proposed solution section, you show how you can alleviate your prospective buyer’s pain points. This can fit onto the problem statement section but if you have a comprehensive solution or prefer to elaborate on the details, a separate section is a good idea.
Spare no details regarding the solution you will provide. When you write a business proposal, explain how you plan to deliver the solution. Include an estimated timeline of when they can expect your solution and other relevant details.
For inspiration, look at how this business proposal template quickly and succinctly outlines the project plan, deliverables and metrics :

At this point, the prospect you’re pitching your solution to likes what they’re reading. But they may not trust you to deliver on your promises. Why is this?
It’s because they don’t know you. Your job is to convince them that you can fix their problem. This section is important because it acts as social proof. You can highlight what your company does best and how qualified your team is when you write a business proposal for a potential client.

This free business proposal template showcases the company’s accolades, client testimonials, relevant case studies, and industry awards. You can also include other forms of social proof to establish yourself as a credible business. This makes it that much more likely that they will say yes!
Pro Tip: Attaching in-depth case studies of your work is a great way to build trust with a potential client by showcasing how you’ve solved similar problems for other clients in the past. Our case study examples post can show you how to do just that.
To further demonstrate just how prepared you are, it’s important to outline the next steps you will take should your buyer decide to work with you.
Provide a timeline of how and when you will complete all your deliverables. You can do this by designing a  flow chart . Or add a  roadmap  with deadlines. Pitching a long-term project? A timeline infographic would be a better fit.
If you look at this abstract business proposal template below, even something as simple as a table can do the trick.

The timeline is not always set in stone, rather it’s an estimation. The goal is to clarify any questions your potential client might have about how you will deliver for the underlying B2B sales process.
On this page, you can outline your fees, payment schedule, invoice payment terms , as well as legal aspects involved in this deal. You can even use the  Excel Invoice Template  to create professional-looking invoices (including brand logo and other elements) and add them to this page.
The key to good pricing is to provide your buyer with options. A  pricing comparison table can help with this. You want to give your client some room to work with. Make sure you’re not scaring off your client with a high price, nor undervaluing yourself. 
Breaking up your pricing in stages is another great way to make sure your potential client knows what he’s paying for. Look at how this simple business proposal template does this:

The legal aspects can slot right into the terms and conditions section. Alternatively, you can add them to the signature section of the proposal to keep things simple.
Summarize everything you have promised to deliver so far. Include what you expect from your prospective buyer in return.  Add the overall project timeline from start to end, as well as payment methods and payment schedule. This way, both of you will be clear on what is being agreed on.
This step is very important as it outlines all the legal aspects of the deal. That is why the terms and conditions section of your proposal needs to be as clear as possible.

I recommend consulting a lawyer or your legal team when working on this section of the business proposal. If you’re a business veteran and understand the legalities of your business, you can use the same terms and conditions across all your proposals.
The final step of this whole process. Your client has read your business proposal and they want to buy what you have to offer.
Add a small section at the end of your proposal to get the necessary signatures. This way, you and your client can sign the proposal and the partnership becomes official.
Be sure to also include your contact information in your business proposal template. It acts as a gentle prompt to your client to contact you in case they have any questions. A professional way of doig that would be to include an e-business card with your contact details, email i.d and any other social links you want to share. You can go through this article for the best digital business cards .

A business proposal usually aims to answer the following questions: 
	Who you are and what your company does
	The problem your buyer is facing
	The solution your company offers to alleviate the problem
	How your company will implement this solution effectively
	An estimate of resources (time, money, etc) required to implement the solution

You can see how this sample business proposal template covers the above points.

Notice how this proposal template addresses the same project like in one of the previous templates, but uses a completely different design style (more retro, while the previous business proposal template is more modern and minimalistic).
Generally, there are three types of business proposals:
1. Formally solicited 
A formally solicited business proposal is made when you respond to an official request to write a business proposal.
In this scenario, you know all the requirements and have more (if not all) information about a prospective buyer. You simply need to write the business proposal for your buyer to evaluate so you can begin the sales process .
2. Informally solicited 
Informally solicited business proposals are written when there isn’t an official request for a proposal. A prospective buyer is interested in your services and asks for a proposal so they can evaluate it.
An informally solicited proposal requires a lot more research from your end. These types of proposals are usually created out of informal conversations. They are not based on official requests which often contain more detail.
3. Unsolicited 
Think of this as a marketing brochure or a cold email . Unsolicited business proposals will often take a generic, one-size-fits-all approach to business proposals. Unsolicited proposals lack any understanding of the buyer or their requirements.
But with additional  market research , personalization and identifying customer pain points , you can propose a customized solution based on your buyer’s needs. This can be a very persuasive approach, such as in this business proposal example:

Now that you know how to write a business proposal, let’s look at how you can optimize your proposal to deliver results!
Below you’ll find some winning business proposal templates and examples to get you started. I’ve also included some design tips to keep in mind when you’re creating your next business proposal: 
1. Know your audience 
If you have some clarity on who your ideal buyer is — their pain points, their budget, deadlines, among other things — you’ve already won half the battle.
If you are a business that helps clients with everything from running giveaways or helping grow their blog , identify which customers to pitch. This is a sure-shot way to close the deal.
Mapping user personas  for your ideal buyer can help bring some clarity. It will also help you position your business proposal correctly. This improves the chance of your buyer moving your business proposal to the “Yes!” pile.
2. Put your brand front and center
If your company follows certain brand guidelines, incorporate them in your business proposal templates. Consider how business proposal examples like the one below highlight brand identity :

From the color palettes to the company logos , everything follows their brand guidelines. The result: a business proposal that’s consistent across the board.
Pro Tip: Switching this template to match your brand assets is actually pretty easy. Venngage’s My Brand Kit feature allows you to import your color palettes, logos as well as font choices. Any Venngage template can now be your template.
You can also consider this sample business proposal template:

Design companies sure do know their design. They did a phenomenal job keeping their brand colors consistent while opting for a black design. This unique color scheme also makes their white logo prominent throughout the proposal.
3. Try less text, more visuals
Have you ever read a proposal and thought to yourself, “Wow, this is all text and has no images, I love it!”? Yeah, me neither.
The free business proposal template below is a perfect example of the “less is more” principle. It does a phenomenal job of communicating what it needs to. By substituting some of the text with icons and visuals, you get a clean business proposal that’s much more scannable.

Want to keep things strictly professional? Instead of icons, you can always add your team’s headshots. This shows your buyer exactly who they’ll be working with.  
Check out this formal business proposal format for some inspiration:

4. Switch up your business proposal designs
It doesn’t hurt to go above and beyond once in a while. Jazz up your business proposal template with some extra colors. This helps make your business proposal more engaging. It also helps your buyers retain information faster.

The business proposal example alternates between black, white and grey backgrounds. It still manages to maintain consistency in its branding . Just switching up your backgrounds once in a while can also bring in some variety to an otherwise standard business proposal.
This SEO business proposal sample proves that it’s possible to switch up the colors in every other page. But it still maintains the same color scheme across the entire proposal just like a professionally designed website : 

Pro Tip: Not a color expert? Our guide on picking colors can help you pick the right color scheme for your proposals.
FAQ about business proposals
What is the purpose of a business proposal.
A business proposal aims to streamline the B2B sales process (which is often complex ) between you as a seller and a buyer.
It does this by serving the dual purpose of acting as a source of information. The proposal also acts as a sales pitch aimed at convincing your buyer why they should buy what you have to offer.
What are the best practices for business proposal design?
	Do a thorough spell-check. The goal of your business proposal is to convince your buyer why you’re the perfect person for the job. A proposal with typos or grammatical errors communicates the opposite. A thorough spell-check before you send your proposal is a must.
	Keep things clear and readable: Clarity is an important aspect that you have to ensure in your business proposal. If you want your proposal to hit home and make an impact on the buyer, you have to write it in an understandable way. To keep things clear and readable, there are a couple of things that you can do. You can, for one, take care to use easy wording and segmented sentences from the get-go. You can also try paraphrasing the hard parts of your proposal once you are done writing it.
	Let your brand shine. As discussed before, writing a business proposal is all about knowing your ideal buyer and focusing on their pain points. But that doesn’t mean your business proposal template has to be boring. Demonstrate how different you are compared to other companies. You can do this through your brand guidelines , by using more visuals, switching up your proposal design or showing off your personality in your writing . 
	Create a business proposal PDF. Downloading your business proposal in PDF format allows you to attach other collaterals with your business proposal. These can include a company explainer video or case studies showcasing the work done with past clients. Also, who doesn’t love saving paper?

How long should your business proposal be? 
The length depends on the scope of the work as well as the complexity of the project. Here is a one-page business proposal template:

Can your business proposal template really be one page? Yes, as long as you understand who your buyer is and their pain points. You should also have the ability to communicate everything your ideal buyer needs to know about your business in a succinct manner.
Or if you’re feeling adventurous how about just two pages? Often, clients prefer if you go straight to the point and avoid all the fluff.
For example, this green modern marketing proposal template wastes no time in getting down to brass tacks:

Need more inspiration? Check out this blog on the 5 marketing proposal examples that’ll help elevate your business.
There is no one size fits all approach when it comes to deciding how many pages you should include in your business proposal template. And at the end of the day, “the only rules are the ones you set for yourself”.
At the end of the day, writing winning business proposals that sell is all about you understanding your buyer, their potential pain points and positioning yourself as someone who can alleviate those pain points. 
Now that you know how to write compelling business proposals, what are you waiting for?
Take action and start creating your own business proposals to close more deals and grow your business today!
More business communications templates + writing tips you might be interested in…
	31 Consulting Proposal Templates to Close Deals
	How to Write a Project Proposal [10+ Templates]
	20+ Professional Business Letterhead Templates + Branding Tips
	How to Write a White Paper [Tips & Templates]

How to Write a Business Proposal [Examples + Template]
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Free Business Proposal Template

Propose your business as the ideal solution using our Free Business Proposal Templates.
Thank you for downloading the offer.
Here's what every new business owner needs: an extra 8 hours in the day, an endless supply of coffee, and, most importantly, a really strong business proposal.

A business proposal can bridge the gap between you and potential clients. Done correctly, and it will outline your value proposition and persuade a company or organization to do business with you.
Here, we'll take a look at the various kinds of business proposals and go over how to write one. We’ll also see some ideas and examples to help guide yours.

Know exactly what you need? Jump to one of the following sections:
What is a business proposal?
Types of business proposals, how to write a business proposal, business proposal templates, business proposal example, tips for writing a business proposal, business proposal ideas.
A business proposal is a formal document that’s created by a company and given to a prospect to secure a business agreement.
It's a common misconception that business proposals and business plans are the same. However, a proposal helps you sell your product or service — not your business itself.
Think of it this way: instead of assisting your search for investors to fund your business, a proposal helps you seek new customers.
Follow Along With HubSpot's Business Proposal Template

Download the Template for Free
There are two types of business proposals: unsolicited and solicited.
	Unsolicited Business Proposals : With unsolicited business proposals, you approach a potential customer with a proposal, even if they don't request one, to gain their business.
	Solicited Business Proposals : Solicited business proposals are requested by prospective clients so that they can decide whether to do business with your company.

In a solicited business proposal, the other organization asks for a request for proposal (RFP). When a company needs a problem solved, they invite other businesses to submit a proposal that details how they'd solve it.

Propose your business as the ideal solution using our Free Business Proposal Templates
	Problem summary
	Proposed solution
	Pricing information
	Project timeline

You're all set!
Click this link to access this resource at any time.
Fill out the form to get your template.
Whether the proposal is solicited or unsolicited, the steps to create your proposal are similar. Make sure it includes three main points:
	A statement of the organization's problem
	Begin with a title page.
	Explain your why with an executive summary.
	State the problem or need.
	Propose a solution.
	Share your qualifications.
	Include pricing options.
	Summarize with a conclusion.

Before writing your business proposal, it's crucial you understand the company. If they've sent you an RFP, make sure you read it carefully, so you know exactly what they want.
I recommend having an initial call or meeting with any new clients to ensure you fully understand their objectives. Ask open-ended questions to understand not just what they want, but why they want it.

Once you've done your research, it's time to begin writing your business proposal. While there's no one-size-fits-all approach to writing a business proposal, there's several elements most proposals include. (I designed this example business proposal using Canva .)
1. Begin with a title page.
You have to convey some basic information here. Introduce yourself and your business. Be sure to include:
	Your company's name
	The date you submitted the proposal
	The name of the client or individual you're submitting the proposal to

Your title page should reconcile engagement with professionalism. I think of it as your first tone-setter, so you need to make sure yours is sleek, aesthetically appealing, and not too "out there."
Here's an example of what a business proposal template looks like when done right:

The executive summary details exactly why you're sending the proposal and why your solution is the best for the prospective client.
Specificity is key here. Why are you the best choice for them?
Like a value proposition, your executive summary outlines the benefits of your company's products or services and how they can solve your potential client's problem.
After reading your executive summary, the prospect should offer a clear idea of how you can help them, even if they don't read the entire proposal. Here's what one should look like:

3. State the problem or need.
This is where you share a summary of the issue impacting the potential client. This is your opportunity to show them you understand their needs and the problem they need help solving.

In the example above, I included several signals to showcase my expertise – that I've been in the photography biz for 10 years, that I've worked with over 500 clients, and that I've been featured a number of publications. 
As you approach this section, focus on presenting yourself as an authority. Consider leveraging tools like:
	Case studies
	Client testimonials
	Relevant awards
	Industry accreditations

6. Include pricing options.
Pricing is where things can get a bit tricky, as you don't want to under or over-price your product.

The pricing section of your proposal could include:
	A detailed pricing breakdown, including packages, tiers, and add-ons or optional services
	How product features and benefits align with pricing choices
	Pricing for different needs and budgets
	How your pricing compares with competitors
	An FAQ section to respond to anticipated objections and explain your pricing strategy

7. Summarize with a conclusion.
After sharing the above information, simplify it all into one final section.
	First, briefly summarize the proposal. Be sure to share your qualifications and why you’d serve as the best choice.
	Then, to prompt further conversation, confirm your availability to go over the next steps.
	At the end of the proposal, the goal is to have the client ready to work with you. So, be sure to offer your contact information for easy follow-up.

In need of some inspiration before you begin writing? Here are example business proposal templates from popular business proposal software companies you can use to help create your proposal.
1. HubSpot's Free Business Plan Templates

Download these Templates
We know how crucial a great business proposal is to your and your client’s success. That's why we've compiled 2 Free Business Proposal Templates for you to use and customize for any of your projects.
You'll gain access to a concise, one-page template (pictured above), as well as a longer template for you to refine your plan and proposal.
Download the templates now to get started on building your proposal.
What We Like
The one-page template is clear, straightforward, and easy to read — without skipping on the key elements of a business proposal. This format is especially useful for busy clients who appreciate brevity and clarity.
2. Web Design Proposal

With advertising on social networks projected to reach $82.23 billion dollars in 2025 , it's in your business's best interest to have a plan for growing your client's social media presence.
To help you in that effort, the information in this social media marketing proposal includes an executive summary to help introduce your high-level ideas, an assessment of the client’s company to show your diligence, and a breakdown of billing to show how your company charges for posting, content creation, and analytics.
This template includes all the bells and whistles of a social media proposal packaged in a fun yet professional design. It also includes helpful writing instructions under each section.
8. Content Marketing Proposal

Business proposal templates are helpful places to get started, but what should your business proposal look like when it's complete? This template should inspire you.
When pitching your content marketing services to clients, this template can help you organize your ideas. While it walks you through initial objectives and how to communicate your prospected results, one of the most helpful parts of this template is the pricing ideas it gives you when charging for your services.
In the business template example below, Social Portal Consulting (SPC) pitches a marketing proposal to Graphic Bean. At first sight, this proposal appeals to the creative. I recommend going a step forward and designing the layout in your or your client’s brand colors.

Besides the design, the social media icons quickly tell the prospect what platforms Social Portal is pitching. Because we see Facebook, Twitter, Instagram, and Pinterest icons, the client instantly knows that this proposal doesn’t include LinkedIn, YouTube, or other platforms.
While maintaining its design, this example outlines Social Portal Consulting’s plans efficiently. It begins by providing insight into Graphic Bean and its goals before elaborating on how SPC can leverage its expertise to help them achieve them.
This business proposal template includes an easy-to-follow timeframe for goals and objectives while keeping the client abreast of how payment will happen across the project.
Overall, this is an excellent example of how to combine the elements of social media marketing into a creative and concise business proposal. Finally, we'll leave you with some business proposal ideas to get you started on your own.
	Start with an outline.
	Keep it simple.
	Stay on brand.
	Quality control.
	Include data and visuals.
	Add social proof.
	Use a call-to-action.
	Create a sense of urgency.
	Make the decision for them.
	Incorporate video into your proposal.
	Include up-sell and add-on opportunities.
	Clarify your terms and conditions.
	Include a space for signatures to document agreement.
	Create a table of contents.

1. Start with an outline.
If you want to produce a thoughtful, effective business proposal, you need to have some idea of what you're hoping to achieve with it.
Before I dive into writing a proposal, I always outline the major sections of the proposal that I want to include. That way, I can stay focused and make sure my message stays intact as I write.
Use these free business proposal templates to make sure that your outline includes everything you need.
2. Keep it simple.
Ultimately, there's no definitive blueprint for how long a business proposal has to be. Yours should be however long it takes to convey the information you want to get across.
That said, I'm a firm believer in quality over quantity, especially when it comes to business proposals. Keep your sentences short and simple, and avoid including too much business jargon.
You want anyone who picks up your proposal to make sense of it. So, be straightforward and don't get too fancy. Aim for substance over flash.
3. Stay on brand.
Don't be afraid to let your company's personality shine through in your proposal. Stay true to your brand and show the client what sets you apart from your competitors.
4. Quality control.
I've made it a habit to add an editing/QA step in my writing process. During this step, I do a quick spelling and grammar check before hitting send.
So, as you draft your proposal, and after checking for the basics, keep scanning this document until it's just right.
Check to make sure your proposal:
	Meets client needs and expectations
	Highlights your value proposition
	Is well-structured and easy to read or skim
	Complies with legal, ethical, and regulatory requirements
	Looks professional and engaging

5. Include data and visuals.
You want your business proposal to capture your prospect's attention and help set you apart from any other ones they might have received. One of the best ways to do that is to include hard, quantitative data that helps stress the value of your business.
Use relevant, compelling figures that highlight what you have to offer. This can establish authority and make your proposal more convincing. It also helps to include visuals such as charts and graphs to enhance your proposal.
6. Add social proof.
From my experience, you can only be so convincing when you're personally talking up how great your business is — which is why adding social proof is key to establishing credibility.
At the end of the day, prospects are skeptical. They may not take you at your word. But they'll likely trust peers and fellow customers. That's why including elements like customer quotes and testimonials can go a long way.
7. Use a call-to-action.
I've learned that the best proposal in the world can only take you so far if you don't clearly define the next steps. That's why you have to make sure the reader knows what to do after reading your proposal.
A clear call-to-action is the best way to get there.
Define and highlight exactly what they should do to act on the interest your proposal has generated. Without that guidance, you might leave your reader in limbo.
HubSpot customers : Use this CTA builder to create powerful customized CTAs.
8. Create a sense of urgency.
No one wants to feel as if they missed out on a great opportunity. From my experience, prospect tend to drag their feet and put off making a decision if there isn't a sense of urgency.
So, as you create your business proposal, your goal should be to add a degree of urgency. When prospective clients read your business proposal they should feel that the best time to sign up for your service is now .
One way I accomplish this is by stating short and long-term goals for their business. They'll have to wait for the long-term goals, but I make the short-term goals so enticing that they'll be ready to begin a collaboration.
9. Make the decision for them.
Craft your copy in a way that seems like saying "no" to the proposal would be stepping over dollars to pick up pennies. Your offer should go above and beyond their expectations. Do everything in your power to remove friction and objections along the way.
10. Incorporate video into your proposal.
If you're creating an online proposal using document file formats like PDF, add multimedia elements. This will enhance the proposal experience, make your document richer, and keep them engaged.
Try adding a video at the beginning as an intro to your proposal. Or, put a video in the project breakdown to verbally discuss some of the more confusing parts.
Extras like this can make an impression. This tip works especially well with prospects who are visual or auditory communicators.
Pro tip : HubSpot Video makes it easy to record and embed video into a website or email for a big proposal boost.
11. Include up-sell and add-on opportunities.
They say you won't receive unless you ask. And readers won't explore the upper tiers of your solutions if you don't give them the opportunity.
So, share some upsells and add-ons about your business that they can act on. Call out a specific pain point and how this extra can add value.
With this step, balance is important. Show them everything your business has to offer without overwhelming your recipient.
12. Clarify your terms and conditions.
Your business proposal should include details on your project timeline and payment schedule. This summary is basically what you and the client agree to if they accept your proposal.

Don't forget to share this post!
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10 Free Grant Proposal Templates for Stellar Grant Writing
ClickUp Contributor
February 13, 2024
Are you on the hunt for a grant?
Whether you need funding for an educational program or you’re ready to start a nonprofit, venturing into the world of grant writing isn’t for the faint of heart. But you’re here to make a difference, and that’s why you need a solid, well-structured proposal to get the funding you need. 
A polished grant proposal persuades potential grantees of your project’s viability. Maybe you’re sitting at your computer, trying to start the grant writing process, but you’ve got serious writer’s block.
You could be unsure how to format an entire grant proposal from beginning to end. Wherever you are in your journey, there’s a grant proposal template to help you.
In this guide, we’ll look at how grant proposals work, explain what you should look for in grant writing templates, and share our top 10 templates to use. ✨
What makes a winning grant proposal template? 3 tips to remember
1. clickup grant proposal template, 2. clickup grant writing scope of work template, 3. clickup chatgpt prompts for grant writing template, 4. clickup nih grant statement of work template, 5. clickup non-profit organization project proposal template, 6. clickup non-profit organization work breakdown structure template, 7. clickup community assistance program project proposal template, 8. pdf grant proposal template by signaturely, 9. word grant proposal template by wise, 10. grant proposal template by pandadoc, what is a grant proposal.
A grant proposal is a formal document outlining a request for funding. It’s usually submitted to a government agency, corporation, or any other organization offering grant funds or budget opportunities.
Successful grant proposals share information about your proposed project in a persuasive way. Not only do you need to share pertinent information about your project, but you also need to make a pretty good case for why you deserve this funding—especially if you’re asking for a lot of money. 
Every project is different, but writing grant proposals usually include:
	Cover letter: A brief intro that offers an overview of why you’re requesting funding and your eligibility for this research grant
	Executive summary: A concise paragraph detailing the problem, solution, requested grant funding amount, and expected outcomes
	Statement of need : This is a detailed explanation of the problem the project should solve
	Project description: This gives grant reviewers an outline of the project itself, detailing a timeline and methods
	Grant budget : Create an itemized financial plan showing how much you need, for what, and why
	Organizational information: This briefly explains who you are, your track record, and why you’re equipped to handle this project

Not to spook you, but grant writing is super competitive. That’s why it’s best to use a grant proposal template to lay out your ideas in the clearest, most persuasive way possible. 📚
Templates can be huge time-savers, but not all templates are helpful. If you’re on the hunt for a time-saving template, follow these tips to find the best option for your project:
	Go for an AI proposal writing tool : Struggling with writer’s block? AI tools like ClickUp AI take your project details and magically fill in your template. You should still review this copy, of course, but AI will definitely keep you on track
	Sound structure: Grant proposals can get pretty long and dry if you aren’t careful, so look for templates with built-in organization. They should have a table of contents and plenty of headings to break up the text
	Collaboration: You probably aren’t writing a proposal solo. Look for templates that allow collaborators, key personnel, and stakeholders to view and edit the proposal at the same time

10 Free Grant Proposal Templates to Get You More Grants
Sure, you could create your own grant proposal. But why spend hours making your own proposal when there are so many high-quality templates out there for the taking? 
When you need funding in a jiffy, use these 10 grant proposal templates to make your case with less time and hassle. 

Need a template that not only organizes your proposal but the application process itself? Look no further than the ClickUp Grant Proposal Template . 
This free template comes with plenty of helpful features, including custom statuses, like Open and Complete , to track every element of the grant proposal. If you’re writing proposals as a team and need to track which parts are done—and which still need your attention—this template is a major time-saver. 
Toggle between four different views to display your grant application in different formats. This template also integrates with ClickUp project management tools , so it’s perfect for adding structure to the proposal process. 
Add comments and reactions, track the time you spend working on the grant proposal, and tag staff members in just a few clicks. Leverage ClickUp’s 100+ Automations to keep your grant proposal process moving and hand off tasks between team members at the speed of light. ⚡

A project’s scope of work should outline the project itself, its goals, activities, and end results. Potential funders want to see time frames, milestones, and amount of funding in the scope of work too. 
If that sounds like a lot of information to gather on your own, we’ve got you covered. The ClickUp Grant Writing Scope of Work Template provides a step-by-step framework for you to write a solid, organized scope of work. 
This template helps you include all the necessary information to write airtight scopes of work. It comes with statuses like Draft , In review , and Finalized so you can easily track the progress of the grant writing project itself.
Add Custom Fields like Grant Name, Funding Organization, Application Deadline, and Budget Allocation to track the details of multiple grant programs without getting confused.
Best of all, this template is 100% customizable. You’re free to use the premade structure, colors, and fonts, but it’s best to drop in your own branding to make a good first impression on the funding agency.

Look, we aren’t saying you should let ChatGPT handle every aspect of your grants, but you can definitely use it to speed up the writing process. The trick to AI writing tools like ChatGPT is knowing how to prompt the AI to get quality answers, and that’s where the ClickUp ChatGPT Prompts For Grant Writing Template comes in handy. 
This guide includes tons of helpful prompts to feed to ChatGPT and generate high-quality copy for your grants, cover letter, and more. If you’re fighting writer’s block and need that proposal written, like, yesterday , this template will help you write everything at light speed with AI.
As long as you fill in the variables with your information, you’re golden. The template includes prompts like: 
	“I’m looking for tips on how to write a successful grant proposal that will convince the [grant-giving organization] to fund our [goal]”
	“I need to create a narrative that outlines the need for our [project or initiative] and why it should be funded by the [grant-giving organization]”
	“I’m looking for strategies to ensure our grant proposal stands out from the competition and will be chosen for funding”

If you don’t want to waste time flipping between ClickUp and ChatGPT, simplify things by using ClickUp AI to write your template lickety-split.

A National Institutes of Health (NIH) grant is the major league of grants. If you need a research grant or work for a health-related organization, this specific grant is a must-have.
NIH grants have their quirks, which is why we created the ClickUp NIH Grant Statement of Work Template . You’ll likely need more templates for the other portions of your grant request, but if you’re looking for help with your statement of work (SOW), you’re in the right place, friend. 
This SOW template:
	Defines project goals, deliverables, and project timelines
	Outlines your strategy
	Defines responsibilities for all team members

It includes statuses, Custom Fields, and different views to make this template your own. 

As a non-profit, you know how critical it is to secure funding to support your mission. Write more effective grant proposals with the ClickUp Non-Profit Organization Project Proposal Template .
It’s tailored to the needs of non-profit grants and includes:
	Project objectives
	A budget section
	Social impact visualizations
	An actionable plan for implementation

This sample grant proposal comes with custom statuses and Custom Fields, but we’re really proud of the Whiteboard view. Use the Project Proposal view to brainstorm project ideas and follow the Getting Started Guide view to kickstart your grant proposal. 

We know how all-consuming proposals can be. But it’s still important to keep your eyes on the prize even while you’re writing a project proposal . Make sure you have the structure in place to manage projects once you secure funding—you never know when it will be showtime!
The ClickUp Non-profit Organization Work Breakdown Structure Template breaks even the most complex non-profit tasks down into more manageable tasks. Use this template to create tasks and assign them to your team. 
It will even keep track of your progress, manage your project budget , and track expenses in the same dashboard. If you’re a scrappy nonprofit organization trying to do more with few resources, this all-in-one template is a must-have for project descriptions, research projects, and so much more.

A community assistance program (CAP) provides support to members of a specific community. CAPs provide financial aid, food, educational resources, housing assistance, support groups, and much more.
Are you looking to launch a community assistance program? The ClickUp Community Assistance Program Project Proposal Template is just the template for you. 🌻
Use the Project Proposal View to outline your specific goals and key deliverables in one place. ClickUp makes it a cinch to collaborate with your team and brainstorm ideas within the project so you create an effective grant proposal that secures funding. 

Need something with fewer bells and whistles? The PDF Grant Proposal Template by Signaturely is a free download in either Word Doc or PDF format. 
This generic grant proposal template includes formatting, headers, and sections, although it does lack the pretty colors, visuals, and collaboration features you’ll find with the other templates on this list. Even so, it’s a perfect option for anyone who wants a simpler proposal template with just the essentials. 
Bonus: Proposal Management Tools

Wise’s Word Grant Proposal Template is a Word Doc template that comes with everything you need to win funding, including:
	Executive summary
	Project overview
	Scope of work
	Terms and conditions

This is a bare-bones generic grant proposal template, though, and you’ll need to supply pretty much all of the copy for this business proposal template . We recommend using a tool like ClickUp AI to write relevant content for this free template—just be sure to double-check the copy before sending it to the grantors.

PandaDoc created a gorgeous proposal template with both formatting and content prompts. With well over 10,000 uses, this template is a popular option for creating show-stopping proposals that turn heads. 
This template works like Mad Libs, where you fill in the blank with your details. If you don’t have this information or just aren’t sure what to say, you can always use AI-powered grant proposal writing tools for inspiration. 
Just make sure you personalize this grant proposal with your own unique flair. It comes with fonts and a color scheme out of the box, but feel free to customize this document so it looks like it’s actually from your organization.
Score Grant Funding and Manage Projects on One Platform
If you’re a first-time grant writer, it might feel like you’ve got your work cut out for you. Remember, it’s not just about presenting the facts: This is your chance to communicate your vision and story. 🔮
Focus on the meat of your message and let these templates do the heavy lifting for you. The 10 templates in this guide will streamline your messaging, save time, and simplify fundraising.
But what do you do once you have funding?
After a much-needed celebration and a nap, plug your communications, tasks, deadlines, templates, and meeting notes into ClickUp.
See the difference firsthand: Create a free ClickUp account in seconds .
Questions? Comments? Visit our Help Center for support.
Receive the latest WriteClick Newsletter updates.
Thanks for subscribing to our blog!
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	Free training & 24-hour support
	Serious about security & privacy
	99.99% uptime the last 12 months

	Integrations
	Real Estate
	Legality Guide
	Signature Generator
	Get Started Now — It’s Free!
	Sign Up for Free
	Sign Templates /

Grant Proposal

A grant proposal is a formal document that requests a financial budget, investment, or funding from the grantees. Jotform’s free Grant Proposal includes a cover letter, terms and conditions, and space to lay out proposed project details. Make any changes you like to this ready-made template — then share it with others to be filled out and signed from any device. Once both parties have signed, a finalized PDF document will be automatically sent to your inbox — ready to download, print, and share with grantees.
Want to make changes to this Grant Proposal? No problem! With Jotform’s drag-and-drop builder, you can easily include your own personal branding, add or remove text and signature fields, change fonts and colors, update terms and conditions, and make other cosmetic changes. Get funding for your next big project with this fully customizable Grant Proposal from Jotform. If you’d like to save time by automating your workflow, do it with Jotform Sign ’s powerful e-sign solution.
More templates like this

Free Business Proposal Template
Getting your business off the ground is no small task and might require gathering funding from investors. With Jotform Sign’s free business proposal template, you can present your new business’s needs, ideas, and benefits to potential investors — making it easier to get their buy-in. A business proposal template is a tool for entrepreneurs to quickly and effectively create professional business proposals without having to start from scratch. Just create and customize your proposal, then send it to your investors and other stakeholders for their e-signatures.Need to make changes to your business proposal template? No problem! With Jotform, you can drag and drop elements to personalize your proposal and match your company branding. You can add or remove form fields, create an automated signing order for multiple investors, upload logos and branding, and choose fonts and colors that work best for you. Work smarter with Jotform Sign!

Free Project Proposal Template
Don’t waste time creating multiple project proposals from scratch. With Jotform Sign’s ready-made Project Proposal template, you can generate and customize a professional-looking proposal that includes details such as an overview and description of the project, resources and budget, project goals, expected outcomes, and more. Update the wording however you see fit, then share it with clients via email to seamlessly gather e-signatures from any device.Want to personalize this Free Project Proposal to match your company’s branding with Jotform White Labeling? No problem! Using our powerful online builder, you can add or edit form fields, upload your logo and branding, include images, change fonts and colors, and make other design changes without any coding. Once both you and your client have signed this proposal, you’ll automatically receive a finalized document — ready to share, download, and print for your records.

Mobile App Development Proposal Template
Create a Mobile App Development Proposal Template that works for all occasions with Jotform Sign. With our entirely online signature and feedback collection process, you’ll be able to manage and reference signatures from your team members in one convenient place. Share via email or embed in your online team portal.Customizing this Mobile App Development Proposal Template is simple and efficient with Jotform Sign. Update the terms and conditions, add or remove form fields, change fonts and colors, and make other cosmetic changes with no coding required. Create your app proposal, send it straight to your team, and start collecting signatures and feedback instantly. Collaborate smarter with Jotform. To collect e-signatures on any device, create an e-sign document with Jotform Sign.
How do you fill out a grant proposal template?
Depending on the form builder you use, filling out a grant proposal template could be as easy as clicking on form fields and entering your unique information.
With Jotform’s Form Builder , you can easily fill out your template in a matter of minutes. Simply select the template that best suits your needs and start entering your information. Beyond these form fields, you can edit your template’s body copy to make updates to your company name, mission, executive staff, and more.
Your template’s fields are customizable to fit your needs. Add or delete form fields using Jotform’s drag-and-drop interface.
What kind of information should be provided when filling out a grant proposal template?
While most templates will include a number of predefined fields, not every field is vital to your grant proposal’s success. However, there are a few key pieces of information that you’ll need to include for a chance at acceptance. These include
	Recipient information
	Cover letter
	Project details
	Start and end date
	Project title
	Purpose of your project
	Narrative/needs statement
	Project timeline
	Goals and objectives
	Terms and conditions

Including this information will ensure your proposal is comprehensive and complete. A lack of detail will put your chances of success at risk, so be sure to check every field for accuracy before submitting.
What are the different types of grant proposal templates? 
There are a number of grant proposal templates available online. Which one you choose will depend on your needs, purpose, and industry. Some common types of grant proposal templates include
	Grant budget
	Application template

Jotform has more than 40 proposal templates to choose from, so you can find the one that best suits your needs. If you can’t find one that checks all your boxes, use Jotform’s Form Builder to create one from scratch. And you can use Jotform’s PDF Editor to modify grant proposal templates you’ve found or used in the past to make them your own.
What are some grant writing tips?
The best grant proposals differentiate themselves from the hundreds, or even thousands, of other proposals that an approval board must read. Here are some key tips to consider when writing your grant proposal:
	Tell your story. A compelling story will separate you from the crowd.
	Describe why you need your grant. Include a clear, actionable plan that shows commitment, research, and organization.
	Include a well-thought-out budget. Make sure your budget is approved by an expert before sending.
	Keep it simple. Don’t try to impress the approval board with overly complicated words that don’t add value. Write clearly and concisely. Get to the point.

By remaining transparent, your proposal will rise to the top and you’ll improve your chances of success.
These templates are suggested forms only. If you're using a form as a contract, or to gather personal (or personal health) info, or for some other purpose with legal implications, we recommend that you do your homework to ensure you are complying with applicable laws and that you consult an attorney before relying on any particular form.
Your account is currently limited to {formLimit} forms.
Go to My Forms and delete an existing form or upgrade your account to increase your form limit.
All Formats
Proposal Templates
20+ funding proposal templates – word, pdf, pages.
There are a lot of templates for proposal as there are various types of proposals we have, depending on the kind of document you want to make. One of the purposes of creating a proposal is to describe the important points of the reason as to why it is planned in the first place, the objectives, benefits, etc. The most common type of financial proposal that people can use is the funding proposal.
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Business growth
Business tips
20 free proposal templates to ace your pitch

In my vast experience of convincing people to do things they're initially sure they don't want to do, I've picked up a trick or two—namely, that no matter how exceptional and transformative your product may be, if your proposal doesn't articulate its value, you might as well fold it into a paper airplane and throw it out a window.
Impactful proposals require structure, which is where a proposal template comes in. It's the strategic framework that turns your pitch into the corporate equivalent of standing outside someone's house with a boombox over your head—except instead of blasting Peter Gabriel, you're serenading prospects with solutions to their pain points.
Here, in a burst of generosity characteristic of neither me nor most of the business industry, I'll share 20 free proposal templates and show you how to use them to showcase your unique offerings.
Table of contents:
How to choose the right proposal template for your needs
Free business proposal templates for any industry, tips for optimizing a proposal template for your business, proposal template next steps, what is a proposal.
A proposal is a persuasive document used to convince someone to buy into your project, idea, or business opportunity. It outlines what you plan to do, how you plan to do it, when you plan to do it, and how much it will cost.
A proposal is the first—and sometimes only—shot to make an impression. It's your opportunity to prove that you understand a potential client's underlying needs and showcase why you're the best choice for the job. A well-crafted proposal can mean the difference between popping Champagne and crying into your takeout.
There are two types of business proposals:
Solicited proposals are submitted in response to a formal client request for proposal (or RFP) and have specific requirements issued by the client.
Unsolicited proposals , sometimes called proactive proposals, are offered to a prospect independent of a request, usually following discussions about their business needs.
Proposals come in all shapes and sizes, from a quick email pitch to a 100-page grant proposal with a budget the size of a small country's GDP. The key is choosing the right level of detail for your audience and objectives. 
If responding to an RFP from a big company, you should roll out the red carpet with videos, case studies, client testimonials—the works. For a small business owner you've been nurturing for months, a short but compelling proposal focused on key benefits and next steps is likely all you'll need.
At the end of the day, a solid proposal should convince your reader that you understand their problems and have the solutions to fix them.
Choosing the right proposal template for your business needs is a strategic decision. 
Different objectives call for a different approach and, thus, a different template. The one you choose should align with your needs and requirements to fit your project like a glove (or at least like a comfortably loose mitten). 
Follow these steps to get started:
Ask yourself, "What is the core purpose of this proposal?" (Not in the existential sense—that's a spiral no one needs.) For example, a project proposal template should facilitate a clear outline of objectives, deliverables, and timelines, while a business proposal template might focus more on market analysis and competitive edge.
Next, consider who's sitting across the table from you. A contract proposal for legal professionals will differ vastly from a storyboard proposal aimed at creatives. The template should speak their language and cater to their expectations. 
Lastly, consider your desired outcome or what you're after. Are you looking to win a contract, forge a partnership, or charm the coins out of investors' pockets? Your template should have all the necessary details to prompt a reaction more positive than the one I get when I say I'm a writer at a family gathering.
Crafting polished proposals is key to winning new clients and growing your business. But who has the time to start from scratch every time? These business proposal example templates have got you covered. Clients and customers will be so impressed with your beautifully crafted proposal that they won't even realize how little effort it actually took.
Project proposal template

A project proposal outlines the details of a specific project, including an executive summary, objectives, scope, timeline, and costs, submitted for approval or funding. It's essentially a wishlist of how you plan to spend someone else's money.
Best used for: Securing funding or approval for a project
Who should use it: Project managers, business owners, entrepreneurs, non-profit organizations
Business proposal template

A business proposal is a comprehensive offer from a business to a prospective client detailing how the business can meet the client's needs and the benefits of choosing its services or products.
Best used for: Securing funding from investors, attracting new clients, or partnering with other businesses
Who should use it: Business owners, entrepreneurs, sales professionals
Job proposal template

A job proposal helps freelancers pitch their services effectively to potential clients. It emphasizes understanding client needs and providing a breakdown of project costs, which improves pitch quality and increases the chances of securing valuable client partnerships.
Best used for: Securing freelance work
Who should use it: Freelancers of all types, including writers, designers, developers, and more
Proposal letter template

A proposal letter is written to offer a solution or service to a potential client, providing an overview of the benefits and value proposition .
Best used for: Concisely presenting a proposal to a potential client or partner
Who should use it: Business owners, sales professionals, freelancers
Contract proposal template

A contract proposal is a formal offer detailing the terms and conditions under which a party will perform services or deliver goods to another party. It's the prenup of the business world.
Note: always run such contracts by your legal team to ensure they align with your interests and comply with relevant laws.
Best used for: Securing a contract with a client or partner
Who should use it: Business owners, sales professionals, lawyers
Event proposal template

An event proposal is a detailed plan submitted to stakeholders outlining the concept, logistics, budget, and expected outcomes of a proposed event. It's the party planner's battle strategy, where success is measured not in conquests but in compliments and clinking glasses.
Best used for: Securing funding or approval for an event
Who should use it: Event planners, non-profit organizations, businesses
Content marketing proposal template

A content marketing proposal is a strategic plan presented to a client outlining how content marketing can be used to meet their business objectives , including tactics, content types, and measurement methods.
Best used for: Securing a content marketing contract with a client
Who should use it: Content marketers, freelancers, agencies
Proposal planning template

A proposal plan is a structured document that outlines the approach, resources, and timeline for accomplishing a specific goal or project. It's essentially admitting you need a plan to make your plan. It's plans all the way down.
Best used for: Ensuring that a proposal is well organized, persuasive, and complete
Who should use it: Anyone who writes proposals, including business owners, sales professionals, freelancers, and non-profit organizations
Research proposal template

A research proposal is a systematic plan proposing a research project, typically including the research objectives, methodology, timeline, and estimated budget—the "hold my beer" for academics.
Best used for: Securing funding or approval for a research project
Who should use it: Researchers, academics, students
Budget proposal template

A budget proposal is a financial plan that estimates the income and expenditures for a specific project or department over a set period—a bean counter's dream.
Best used for: Securing funding or approval for a budget
Who should use it: Project managers, event planners, business owners
SEO proposal template

An SEO proposal outlines a strategy for improving a client's search engine rankings , including tactics, tools, and expected outcomes. It basically says, "Follow me, and I'll show you how to be more sought-after than a parking spot at Trader Joe's on a Saturday."
Best used for: Securing an SEO contract with a client
Who should use it: SEO professionals, freelancers, agencies
Web design proposal template

A web design proposal outlines the scope, design, functionality, and cost of a website developed for a client. It essentially helps navigate the journey from "Hey, I need a website" to "Wow, this is exactly what I envisioned!"
Best used for: Securing a web design contract with a client
Who should use it: Web designers, freelancers, agencies
Sponsorship proposal template

A sponsorship proposal seeks financial or in-kind support from a sponsor, detailing the benefits the sponsor will receive in return. It's like asking someone to pay for your party and, in return, they get their name on all the balloons. It's a win-win, especially if you like balloons.
Best used for: Securing sponsorships for an event or initiative
Who should use it: Event planners, business owners, and non-profits
Social media marketing proposal template

A social media marketing proposal is a plan suggesting strategies for a client's social media presence , including goals, platforms, content, and metrics for success. It's a pitch to make a brand as clickable as a "Which potato are you?" quiz.
Best used for: Securing a social media marketing contract with a client
Who should use it: Social media marketers, freelancers, agencies
Consulting proposal template

A consulting proposal is a document in which a consultant outlines the services they offer to solve a client's problems, including methodology, timeline, and pricing. It's for the Mary Poppins of the business world, swooping in with a bag of tricks to fix everything from their sales strategy to their coffee machine.
Best used for: Securing a consulting contract with a client
Who should use it: Consultants, freelancers, agencies
Service proposal template

A service proposal is a formal offer of a service-based business to a client detailing the scope of services, deliverables, and terms of the agreement. It's like pinky promising you'll do the stuff you're really good at in exchange for cash.
Best used for: Securing a service contract with a client
Who should use it: Freelancers, agencies, businesses
Sales proposal template

A sales proposal helps sales professionals present their products effectively and establish credibility with potential clients by showcasing the company's background and client testimonials.
Best used for: Closing sales deals
Who should use it: Sales professionals
Grant proposal template

A grant proposal is a written request for funding submitted to an organization or government agency, detailing the purpose, plan, and budget of the project needing support. It's like Kickstarter but with more footnotes.
Best used for: Securing funding for a project from a grant-making organization
Who should use it: Non-profit organizations, researchers, academics
Storyboard proposal template

A storyboard proposal is used to visualize and plan a project and is typically a visual representation of the project's key steps, milestones, and deliverables. It's like drawing a treasure map for your project, except the treasure is just meeting your deadlines and hopefully not walking the plank.
Best used for: Securing approval for a storyboard or selling a storyboard to a client
Who should use it: Project managers, business owners, designers
Partnership proposal template

A partnership proposal is a formal document created by an individual or an organization to propose a collaborative relationship with another party. This proposal outlines how the partnership would work, the benefits it would bring to both parties, and the terms and conditions of the partnership. It's commonly used in business contexts where companies, non-profits, or other entities seek to join forces for mutual benefit .
Best used for: Establishing a mutually beneficial partnership
Who should use it: Business owners, sales professionals, non-profit organizations
When it comes to proposal templates, you need to make them work for you, not the other way around. The template is just a jumping-off point. To combat its genericness, it's essential to add your own razzle-dazzle. Here are a few tips to make any old template sizzle.
Tailor content to suit the specific project
When you begin to write a business proposal, the first thing to consider is your audience. Who are you trying to woo, and what will make them open their wallets?
Here's how to do some sleuthing to identify your target reader and customize your pitch to their needs:
Ask questions to get started: What are the client's pain points , and how will you solve them? What's your proposed scope of work and timeline? How much will your services cost? These are the questions a good proposal answers.
Do your research: Check out the client's website and social media profiles. See what they're posting about and what their customers are saying. Look for any public RFPs or project briefs. The more you understand their business and goals, the better you can position your proposal.
Focus on quantifying value using SMART goals: Once you've got a solid understanding of the work, focus on quantifying the value using SMART goals (specific, measurable, achievable, realistic, and time-bound). For example, don't just say you'll increase web traffic—promise a 25% increase in organic traffic within six months. You want the client to think, "This company gets what we need, and they've promised real, measurable impact."
Tailoring your content isn't just about fitting in—it's about fitting so well they can't imagine going with anyone else.
Add visual elements and branding
Long before our brains got rewired to crave the instant gratification of flashy screens and endless scrolling, our ancestors were also suckers for a good visual. There's nothing quite like an eye-catching graph, chart, or image to break up blocks of text and drive a point home.
Photos: Throw in some photos of your smiling face, your product in action, stacks of money, or whatever is relevant and helps tell your story. Just be sure any visuals are high quality and actually add value. And please, no cheesy stock photos of overly enthusiastic business people engaging in unnatural acts of corporate glee.
Infographics: If you have data or statistics to share, turn them into slick infographics. Those colorful, bite-sized bits of visual information are like catnip for proposal readers. But keep your infographics clear and concise. Cramming too much text or too many numbers onto one can make people's eyes glaze over faster than a hot donut.
Company branding: Spice up your proposal format with your company's colors, logo, and fonts—whatever matches your branding. This helps build brand recognition and makes your proposal look more professional. But don't go overboard, or it'll seem like you're overcompensating.
Using visuals and branding in your proposal helps bring it to life, giving readers an instant visual understanding of your company and offer, all while flexing your expertise. And that can only help your chances of getting to yes.
Choose the right language and tone
When choosing the language and tone for your proposal, you have to walk a fine line. Aim for that sweet spot where you sound like a polished pro, but not so much that people think you're actually a robot in a skin suit.
Use balanced language: Avoid stiff, formal language as much as overly casual speak. Expressions like "enclosed herewith, please find" sound pompous, while "wanna" and "gonna" are too laid-back. Simple, straightforward language is the way to go.
Engage your reader: Talk to your reader like you would a colleague or client. Let your passion shine through in a genuine, unforced way. Demonstrate your enthusiasm for the project without the aggressive, frantic energy of someone selling blenders on infomercials at 3 a.m.
Keep promises realistic: While you want to highlight the benefits and potential wins of choosing you, don't make promises you can't keep or claims you can't back up. Share relevant case studies, statistics, and data to build a persuasive yet realistic argument. Your readers will appreciate your honesty and see you as a trustworthy partner.
Meticulously proofread: With the language and tone set, be sure to proofread carefully. Double-check for any spelling, grammar, or punctuation errors that can undermine your credibility and the professionalism of your proposal. Nothing screams "I wrote this in the parking lot" like a typo.
Highlight your unique selling proposition and social proof
You've got to convince your clients you're better than all the other yahoos vying for their business, and the best way to do that is by showing off what makes you uniquely qualified to solve their problems.
Framing your unique selling proposition (USP) in a way that benefits the customer is vital because it makes your offering more relatable and appealing, directly addressing the customer's needs or pain points.
For instance, a company might boast, "Our team has 103 years of collective experience." That's a hefty number, and one can't help but picture a team of Gandalfs shuffling papers and nodding sagely. Yet, without context, it's just a number, as emotionally stirring as announcing you've collected 103 pieces of lint from your dryer.
Instead of just humblebragging about your gazillion years of experience, tell prospects how it benefits them: "Our team's 103 years of collective experience means we spot problems before they arise, we don't waste time upskilling, and, like workplace MacGyvers, we're ready to turn a paperclip and a stick of gum into a solution."
Provide solid evidence that you've done this kind of work before. Share details of similar successful projects, along with social proof like testimonials or case studies from happy clients. Mention any awards or the time you got mentioned in the paper for something other than that misunderstanding about the "borrowed" traffic cone. The more you can demonstrate your experience and expertise, the more credibility you'll build.
Include a strong call to action
At the risk of stating the obvious, which I understand is a cherished tradition in the world of business proposals, one must not, under any circumstances, let a proposal fizzle out at the end without calling out next steps. It's like leaving a high-five hanging—it's awkward and, honestly, a little sad. Give your proposal the kind of finale that has confetti cannons and at least one person in the background slow-clapping until everyone joins in.
Stick the landing by issuing a clear call to action . State what happens next, such as scheduling a meeting to discuss next steps or providing a timeline for getting started. This gives the client confidence in moving forward with your company. Circle back to your key points and re-emphasize the benefits of working together, in case they skimmed the middle part because they were eating a sandwich or something.
Remember, ending a business proposal without a call to action is like forgetting to say "Bingo!" when you've got five in a row—it's a missed opportunity that could cost you more than just mild embarrassment at the senior center. Don't let a weak ending undermine an otherwise slam-dunk proposal. A strong finish could be the difference between a lost opportunity and your next big client.
While these proposal example templates are helpful, they're only the starting point. The real magic happens when you customize the template to match your unique voice and vision. And if you create lots of proposals, take it to the next level by trying out a dedicated proposal app or automating your workflow .
Related reading:
How to write a statement of work
How to craft your brand message
Business startup checklist: How to launch a startup step by step
How to write a proof of concept
The best apps for freelancers
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We’ve gathered the most useful collection of business plan PDF templates and samples, including options for organizations of any size and type.
On this page, you’ll find free PDF templates for a simple business plan , small business plan , startup business plan , and more.
Simple Business Plan PDF Templates
These simple business plan PDF templates are ready to use and customizable to fit the needs of any organization.
Simple Business Plan Template PDF

This template contains a traditional business plan layout to help you map out each aspect, from a company overview to sales projections and a marketing strategy. This template includes a table of contents, as well as space for financing details that startups looking for funding may need to provide. 
Download Simple Business Plan Template - PDF
Lean Business Plan Template PDF

This scannable business plan template allows you to easily identify the most important elements of your plan. Use this template to outline key details pertaining to your business and industry, product or service offerings, target customer segments (and channels to reach them), and to identify sources of revenue. There is also space to include key performance metrics and a timeline of activities. 
Download Lean Business Plan Template - PDF
Simple 30-60-90 Day Business Plan Template PDF

This template is designed to help you develop and implement a 90-day business plan by breaking it down into manageable chunks of time. Use the space provided to detail your main goals and deliverables for each timeframe, and then add the steps necessary to achieve your objectives. Assign task ownership and enter deadlines to ensure your plan stays on track every step of the way.
Download Simple 30-60-90 Day Business Plan Template
PDF | Smartsheet
One-Page Business Plan PDF Templates
The following single page business plan templates are designed to help you download your key ideas on paper, and can be used to create a pitch document to gain buy-in from partners, investors, and stakeholders.
One-Page Business Plan Template PDF

Use this one-page template to summarize each aspect of your business concept in a clear and concise manner. Define the who, what, why, and how of your idea, and use the space at the bottom to create a SWOT analysis (strengths, weaknesses, opportunities, and threats) for your business. 
Download One-Page Business Plan Template
If you’re looking for a specific type of analysis, check out our collection of SWOT templates .
One-Page Lean Business Plan PDF

This one-page business plan template employs the Lean management concept, and encourages you to focus on the key assumptions of your business idea. A Lean plan is not stagnant, so update it as goals and objectives change — the visual timeline at the bottom is ideal for detailing milestones. 
Download One-Page Lean Business Plan Template - PDF
One-Page 30-60-90 Day Business Plan Template

Use this business plan template to identify main goals and outline the necessary activities to achieve those goals in 30, 60, and 90-day increments. Easily customize this template to fit your needs while you track the status of each task and goal to keep your business plan on target. 
Download One-Page 30-60-90 Day Business Plan Template
For additional single page plans, including an example of a one-page business plan , visit " One-Page Business Plan Templates with a Quick How-To Guide ."
Small Business Plan PDF Templates
These business plan templates are useful for small businesses that want to map out a way to meet organizational objectives, including how to structure, operate, and expand their business.
Simple Small Business Plan Template PDF

A small business can use this template to outline each critical component of a business plan. There is space to provide details about product or service offerings, target audience, customer reach strategy, competitive advantage, and more. Plus, there is space at the bottom of the document to include a SWOT analysis. Once complete, you can use the template as a basis to build out a more elaborate plan. 
Download Simple Small Business Plan Template
Fill-In-the-Blank Small Business Plan Template PDF

This fill-in-the-blank template walks you through each section of a business plan. Build upon the fill-in-the-blank content provided in each section to add information about your company, business idea, market analysis, implementation plan, timeline of milestones, and much more.
Download Fill-In-the-Blank Small Business Plan Template - PDF
One-Page Small Business Plan Template PDF

Use this one-page template to create a scannable business plan that highlights the most essential parts of your organization’s strategy. Provide your business overview and management team details at the top, and then outline the target market, market size, competitive offerings, key objectives and success metrics, financial plan, and more.
Download One-Page Business Plan for Small Business - PDF
Startup Business Plan PDF Templates
Startups can use these business plan templates to check the feasibility of their idea, and articulate their vision to potential investors.
Startup Business Plan Template

Use this business plan template to organize and prepare each essential component of your startup plan. Outline key details relevant to your concept and organization, including your mission and vision statement, product or services offered, pricing structure, marketing strategy, financial plan, and more.
Download Startup Business Plan Template
Sample 30-60-90 Day Business Plan for Startup

Startups can use this sample 30-60-90 day plan to establish main goals and deliverables spanning a 90-day period. Customize the sample goals, deliverables, and activities provided on this template according to the needs of your business. Then, assign task owners and set due dates to help ensure your 90-day plan stays on track.
Download Sample 30-60-90 Day Business Plan for Startup Template 
For additional resources to create your plan, visit “ Free Startup Business Plan Templates and Examples .”
Nonprofit Business Plan PDF Templates
Use these business plan PDF templates to outline your organization’s mission, your plan to make a positive impact in your community, and the steps you will take to achieve your nonprofit’s goals.
Nonprofit Business Plan Template PDF

Use this customizable PDF template to develop a plan that details your organization’s purpose, objectives, and strategy. This template features a table of contents, with room to include your nonprofit’s mission and vision, key team and board members, program offerings, a market and industry analysis, promotional plan, financial plan, and more. This template also contains a visual timeline to display historic and future milestones.
Download Nonprofit Business Plan Template - PDF
One-Page Business Plan for Nonprofit Organization PDF 

This one-page plan serves as a good starting point for established and startup nonprofit organizations to jot down their fundamental goals and objectives. This template contains all the essential aspects of a business plan in a concise and scannable format, including the organizational overview, purpose, promotional plan, key objectives and success metrics, fundraising goals, and more.
Download One-Page Business Plan for Nonprofit Organization Template - PDF
Fill-In-the-Blank Business Plan PDF Templates
Use these fill-in-the-blank templates as a foundation for creating a comprehensive roadmap that aligns your business strategy with your marketing, sales, and financial goals.
Simple Fill-In-the-Blank Business Plan PDF
The fill-in-the-blank template contains all the vital parts of a business plan, with sample content that you can customize to fit your needs. There is room to include an executive summary, business description, market analysis, marketing plan, operations plan, financial statements, and more. 
Download Simple Fill-In-the-Blank Business Plan Template - PDF
Lean Fill-In-the-Blank Business Plan PDF

This business plan is designed with a Lean approach that encourages you to clarify and communicate your business idea in a clear and concise manner. This single page fill-in-the-blank template includes space to provide details about your management team, the problem you're solving, the solution, target customers, cost structure, and revenue streams. Use the timeline at the bottom to produce a visual illustration of key milestones. 
Download Fill-In-the-Blank Lean Business Plan Template - PDF
For additional resources, take a look at " Free Fill-In-the-Blank Business Plan Templates ."
Sample Business Plan PDF Templates
These sample business plan PDF templates can help you to develop an organized, thorough, and professional business plan.
Business Plan Sample 

This business plan example demonstrates a plan for a fictional food truck company. The sample includes all of the elements in a traditional business plan, which makes it a useful starting point for developing a plan specific to your business needs.
Download Basic Business Plan Sample - PDF
Sample Business Plan Outline Template

Use this sample outline as a starting point for your business plan. Shorten or expand the outline depending on your organization’s needs, and use it to develop a table of contents for your finalized plan.
Download Sample Business Plan Outline Template - PDF
Sample Business Financial Plan Template

Use this sample template to develop the financial portion of your business plan. The template provides space to include a financial overview, key assumptions, financial indicators, and business ratios. Complete the break-even analysis and add your financial statements to help prove the viability of your organization’s business plan.
Download Business Financial Plan Template
PDF  | Smartsheet
For more free, downloadable templates for all aspects of your business, check out “ Free Business Templates for Organizations of All Sizes .”
Improve Business Planning with Real-Time Work Management in Smartsheet
Empower your people to go above and beyond with a flexible platform designed to match the needs of your team — and adapt as those needs change. 
The Smartsheet platform makes it easy to plan, capture, manage, and report on work from anywhere, helping your team be more effective and get more done. Report on key metrics and get real-time visibility into work as it happens with roll-up reports, dashboards, and automated workflows built to keep your team connected and informed. 
When teams have clarity into the work getting done, there’s no telling how much more they can accomplish in the same amount of time.  Try Smartsheet for free, today.
Discover why over 90% of Fortune 100 companies trust Smartsheet to get work done.
22+ SAMPLE Small Business Grant Proposal in PDF | MS Word | Google Docs | Apple Pages
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"The aim of an argument, or of a discussion, should not be victory, but progress," French writer Joseph Joubert once stated. Arguing just to hear both views can lead…
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Create a form in Word that users can complete or print
In Word, you can create a form that others can fill out and save or print.  To do this, you will start with baseline content in a document, potentially via a form template.  Then you can add content controls for elements such as check boxes, text boxes, date pickers, and drop-down lists. Optionally, these content controls can be linked to database information.  Following are the recommended action steps in sequence.  
Show the Developer tab
In Word, be sure you have the Developer tab displayed in the ribbon.  (See how here:  Show the developer tab .)
Open a template or a blank document on which to base the form
You can start with a template or just start from scratch with a blank document.
Start with a form template
Go to File > New .
In the  Search for online templates  field, type  Forms or the kind of form you want. Then press Enter .
In the displayed results, right-click any item, then select  Create. 
Start with a blank document 
Select Blank document .
Add content to the form
Go to the  Developer  tab Controls section where you can choose controls to add to your document or form. Hover over any icon therein to see what control type it represents. The various control types are described below. You can set properties on a control once it has been inserted.
To delete a content control, right-click it, then select Remove content control  in the pop-up menu. 
Note:  You can print a form that was created via content controls. However, the boxes around the content controls will not print.
Insert a text control
The rich text content control enables users to format text (e.g., bold, italic) and type multiple paragraphs. To limit these capabilities, use the plain text content control . 
Click or tap where you want to insert the control.

To learn about setting specific properties on these controls, see Set or change properties for content controls .
Insert a picture control
A picture control is most often used for templates, but you can also add a picture control to a form.

Insert a building block control
Use a building block control  when you want users to choose a specific block of text. These are helpful when you need to add different boilerplate text depending on the document's specific purpose. You can create rich text content controls for each version of the boilerplate text, and then use a building block control as the container for the rich text content controls.

Select Developer and content controls for the building block.

Insert a combo box or a drop-down list
In a combo box, users can select from a list of choices that you provide or they can type in their own information. In a drop-down list, users can only select from the list of choices.

Select the content control, and then select Properties .
To create a list of choices, select Add under Drop-Down List Properties .
Type a choice in Display Name , such as Yes , No , or Maybe .
Repeat this step until all of the choices are in the drop-down list.
Fill in any other properties that you want.
Note:  If you select the Contents cannot be edited check box, users won’t be able to click a choice.
Insert a date picker
Click or tap where you want to insert the date picker control.

Insert a check box
Click or tap where you want to insert the check box control.

Use the legacy form controls
Legacy form controls are for compatibility with older versions of Word and consist of legacy form and Active X controls.
Click or tap where you want to insert a legacy control.

Select the Legacy Form control or Active X Control that you want to include.
Set or change properties for content controls
Each content control has properties that you can set or change. For example, the Date Picker control offers options for the format you want to use to display the date.
Select the content control that you want to change.
Go to Developer > Properties .

Change the properties that you want.
Add protection to a form
If you want to limit how much others can edit or format a form, use the Restrict Editing command:
Open the form that you want to lock or protect.
Select Developer > Restrict Editing .

After selecting restrictions, select Yes, Start Enforcing Protection .

Advanced Tip:
If you want to protect only parts of the document, separate the document into sections and only protect the sections you want.
To do this, choose Select Sections in the Restrict Editing panel. For more info on sections, see Insert a section break .

If the developer tab isn't displayed in the ribbon, see Show the Developer tab .
Open a template or use a blank document
To create a form in Word that others can fill out, start with a template or document and add content controls. Content controls include things like check boxes, text boxes, and drop-down lists. If you’re familiar with databases, these content controls can even be linked to data.
Go to File > New from Template .

In Search, type form .
Double-click the template you want to use.
Select File > Save As , and pick a location to save the form.
In Save As , type a file name and then select Save .
Start with a blank document
Go to File > New Document .

Go to File > Save As .
Go to Developer , and then choose the controls that you want to add to the document or form. To remove a content control, select the control and press Delete. You can set Options on controls once inserted. From Options, you can add entry and exit macros to run when users interact with the controls, as well as list items for combo boxes, .
Adding content controls to your form
In the document, click or tap where you want to add a content control.
On Developer , select Text Box , Check Box , or Combo Box .

To set specific properties for the control, select Options , and set .
Repeat steps 1 through 3 for each control that you want to add.
Set options
Options let you set common settings, as well as control specific settings. Select a control and then select Options to set up or make changes.
Set common properties.
Select Macro to Run on lets you choose a recorded or custom macro to run on Entry or Exit from the field.
Bookmark Set a unique name or bookmark for each control.
Calculate on exit This forces Word to run or refresh any calculations, such as total price when the user exits the field.
Add Help Text Give hints or instructions for each field.
OK Saves settings and exits the panel.
Cancel Forgets changes and exits the panel.
Set specific properties for a Text box
Type Select form Regular text, Number, Date, Current Date, Current Time, or Calculation.
Default text sets optional instructional text that's displayed in the text box before the user types in the field. Set Text box enabled to allow the user to enter text into the field.
Maximum length sets the length of text that a user can enter. The default is Unlimited .
Text format can set whether text automatically formats to Uppercase , Lowercase , First capital, or Title case .
Text box enabled Lets the user enter text into a field. If there is default text, user text replaces it.
Set specific properties for a Check box .
Default Value Choose between Not checked or checked as default.
Checkbox size Set a size Exactly or Auto to change size as needed.
Check box enabled Lets the user check or clear the text box.
Set specific properties for a Combo box
Drop-down item Type in strings for the list box items. Press + or Enter to add an item to the list.
Items in drop-down list Shows your current list. Select an item and use the up or down arrows to change the order, Press - to remove a selected item.
Drop-down enabled Lets the user open the combo box and make selections.
Protect the form
Go to Developer > Protect Form .

Note:  To unprotect the form and continue editing, select Protect Form again.
Save and close the form.
Test the form (optional)
If you want, you can test the form before you distribute it.
Protect the form.
Reopen the form, fill it out as the user would, and then save a copy.
Creating fillable forms isn’t available in Word for the web.
You can create the form with the desktop version of Word with the instructions in Create a fillable form .
When you save the document and reopen it in Word for the web, you’ll see the changes you made.

Need more help?
Want more options.
Explore subscription benefits, browse training courses, learn how to secure your device, and more.

Microsoft 365 subscription benefits

Microsoft 365 training

Microsoft security

Accessibility center
Communities help you ask and answer questions, give feedback, and hear from experts with rich knowledge.

Ask the Microsoft Community

Microsoft Tech Community

Windows Insiders
Microsoft 365 Insiders
Was this information helpful?
Thank you for your feedback.
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	PDF Writing a funding proposal
Writing a Funding Proposal Toolkit by Janet Shapiro (email: [email protected] ) - - 1 - - OVERVIEW Brief description This toolkit deals with planning and researching a funding proposal before you write it; how to write the proposal; and the follow-up required once it is written and sent off. There is also an example of a funding proposal to ...




	Funding Proposal Template
Following a project funding proposal template or looking at examples of letters requesting funding makes it easier. There are several elements that need to be present in your proposal.




	Free Grant Proposal Templates
Word | PDF Research Grant Proposal Template Present your hypothesis, literature review, research plans, and projected outcomes with this research grant proposal. This template could be adjusted to suit a scientific research proposal or academic grant application.




	31+ SAMPLE Funding Proposals in PDF
Business Funding Proposal Cover Letter Template download now Free Editable Startup Funding Proposal Template download now Non-Profit Funding Proposal Template download now Startup Funding Proposal Template download now Seed Funding Proposal Template download now Agency Funding Proposal Template download now Free School Funding Proposal Template




	How to Create a Startup Funding Proposal: 8 Samples and Templates to
A startup funding proposal is a document that helps startup founders share an overview of their business and make the case for why they should receive funding. A startup funding proposal can be boiled down to help founders layout 3 things: What — what does your startup do




	Financial Funding Proposal [Free Template]
available Financial Funding Proposal Template Prepared by: [Sender.FirstName] [Sender.LastName] [Sender.Company] Prepared for: [Client.FirstName] [Client.LastName] [Client.Company] Automate your proposal creation and streamline your sales process with our Proposal Software. ABOUT US




	23+ Funding Proposal Templates
Business Funding Proposal Cover Letter Template Details File Format MS Word Google Docs PDF Download Now Free Editable Startup Funding Proposal Template Details File Format MS Word PDF Download Now Sample Non-Profit Funding Proposal Template Details




	How to Write a Business Proposal (+ Examples & FREE Templates)
Home Blog Business How to Write Winning Business Proposal: Examples & Free Templates (2024) By Aditya Sheth, Jan 25, 2024 The great Mark Cuban once said, "Sales cure all." If a business doesn't sell, it doesn't make money and by extension the business fails. That's why you need to write business proposals.




	PDF Writing a Successful Grant Proposal
Preparing a grant proposal is often an involved process. Begin by developing a plan of attack. We suggest you generate a list of tasks and assign different members of your team to different tasks, along with specific due dates. This will help you monitor the progress of your grant proposal.




	Funding Proposal Template
Download in PDF, JPG, PNG and HTML5 format. Create page-turners with Visme's flipbook effect. Share online with a link or embed it on your website. Download this template today to begin creating a funding proposal that is sure to help you reach your funding goals, or browse through the other beautiful templates we offer at Visme for more ...




	How to Write a Business Proposal [Examples + Template]
Here's an example of what a business proposal template looks like when done right: 2. Explain your "why" with an executive summary. The executive summary details exactly why you're sending the proposal and why your solution is the best for the prospective client. Specificity is key here.




	Free Grant Proposal Template
Download the free grant proposal template that suits your business type, to create a grant proposal that reflects your brand and catches the customer's eye. Get contracts with new clients. Complete and customize the simple grant proposal template to give prospective clients all the details they need to hire you for the job.




	Free Business Proposal Template
Getting your business off the ground is no small task and might require gathering funding from investors. With Jotform Sign's free business proposal template, you can present your new business's needs, ideas, and benefits to potential investors — making it easier to get their buy-in. . A business proposal template is a tool for entrepreneurs to quickly and effectively create professional ...




	Funding Proposal Template in PDF
Funding Proposal Template in PDF Nonprofit Organizations Request for Funding Through Writing a Funding Proposal or Fundraising Proposal. Get Comprehensive Proposal Templates From Template.net to Aid Your Cover Letter When Submitting the Proposals to Potential Investors.




	10 Free Grant Proposal Templates for Grant Writing
When you need funding in a jiffy, use these 10 grant proposal templates to make your case with less time and hassle. 1. ClickUp Grant Proposal Template. Use the ClickUp Grant Proposal Template to break down your grant proposal writing process into smaller tasks with due dates, custom statuses, and assignees.




	Grant Proposal
Cloned 26,041 A grant proposal is a formal document that requests a financial budget, investment, or funding from the grantees. Jotform's free Grant Proposal includes a cover letter, terms and conditions, and space to lay out proposed project details.




	20+ Funding Proposal Templates
Details. File Format. Google Docs. MS Word. Pages. Size: A4, US. Download Now. Convince business organizations to sponsor your entity's projects by presenting one of the most convincing proposals. You can do that with ease with the help of this funding project proposal template.




	20 free proposal templates to ace your pitch
A research proposal is a systematic plan proposing a research project, typically including the research objectives, methodology, timeline, and estimated budget—the "hold my beer" for academics. Best used for: Securing funding or approval for a research project. Who should use it: Researchers, academics, students.




	Sample Grants and Business Funding Documents
Business Grant Proposal Template (PDF) Please note, these are the key details you'll want to include in your application. Please follow the instructions outlined by the funding source which may include more or less information.




	Free PDF Business Plan Templates
Simple Business Plan Template PDF This template contains a traditional business plan layout to help you map out each aspect, from a company overview to sales projections and a marketing strategy. This template includes a table of contents, as well as space for financing details that startups looking for funding may need to provide.




	22+ SAMPLE Small Business Grant Proposal in PDF
Small Business Grant Proposal Template download now Sample Small Business Grant Proposal Template download now Small Business Grant Program Proposal download now Small Business Covid-18 Recovery Grant Application Proposal download now Letter for Small Business Marketing Grant Proposal download now




	PDF Sample Cover Letter & Proposal for Funding Support
Proposals to corporations, civic clubs and organizations. Simple corporate or foundation grants not requiring specific application form. Solicitation of sponsorships. (Include donor benefits for each level of sponsorship) Notes for speeches or oral funding requests. Date. Name Organization/Business Address City, State, Zip.




	Create a form in Word that users can complete or print
Open a template or use a blank document. To create a form in Word that others can fill out, start with a template or document and add content controls. Content controls include things like check boxes, text boxes, and drop-down lists. If you're familiar with databases, these content controls can even be linked to data.




	Free Investment Proposal Template
A smart investment proposal template makes it easier to write a stand-out proposal. Add and edit information as you customize your document, using the outline provided in the template, to cover everything your client needs to know. Choose a business investment proposal sample PDF or download an investment proposal template Word document ...
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